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Introduction to APl Based Data Exchange
Tools

DXC is strategically working towards creating an API based Import/Extract Tool which would negate
dependencies on SAP interfaces requiring additional licensing.

— ’ API Based
-IX\- DXC Assure Claims Data

TECHNOLOGY Exchange

The table below shows the release calendar for the new API based Data Exchange tools:

© 2024 DXC Technology Company. All rights reserved.
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Name of Module | Assure Claims version GA

HR Interface 24.3
PUS 23.4
MMSEA 233
MBR 22.3
PositivePay 22.3
1099 23.1

Note

» SAP configuration will no longer be required to run the new API based Import/Extract
tasks.
The new API based Data Exchange solutions will only be accessible via the Configuration
Manager zone.

The respective DA SAP based modules (in the Utilities zone) will not be supported
simultaneously with the new API based solution (in the Configuration Manager zone).
Thus, with the release of DXC Assure Claims v. 23.1, MBR, PositivePay and 1099 tasks will
no longer be available through the old task manager in the Utilities zone.

It is imperative that all the prerequisite settings are performed to get the new API based
Data Exchange modules functional.

Prerequisite Settings

The following one-time settings need to be done in the Configuration Manager/Utilities zones to perform
Data Import/Extract operations. It is imperative that these settings be performed in the exact order
mentioned below.

1. Select the checkbox labeled Use Rule Engine under General System Parameters.

A License Key will need to be entered to enable the checkbox labeled Use Rule Engine.

Please contact Assure Claims Support Helpdesk for assistance.
There are no additional costs associated with generating a License Key for enabling the
Rule Engine feature

© 2024 DXC Technology Company. All rights reserved.
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If you're using the Configuration Manager, navigate to Use Rule Engine checkbox as shown in [Fig. 1]

System Parameters Claims Module (tab)
Setup > General - Rule Engine
System Parameters (subtab)

Configuration

Manager (zone)

DXC Assure Claims (Configuration Manager) screen

=X

€ RMIUT201_ACOFF_FRESH [ DefaultView bi2141bi214 = =]
TecunoLooy
Workin Progress General System Parameters > e x
=] system 2 Employee (=) Diaries / Text Fields £ Claims Module @ Third Party Module

Evaluation Mode Duration

Use Rule Engine

Fraud Analytics Suite

Import/Extract Tool

Line Of Business
Media View Interface
Medical Management
QOFAC

PaperVision Document

Policy Interface

Rule Engine

Script Editor

[Fig. 1]

If you're using the Old Utilities, navigate to Use Rule Engine checkbox as shown in [Fig. 2]

System Parameters

Utilities (zone) - General System System Settings (tab)
Parameters Setup

DXC Assure Claims (legacy Utilities) screen

Utilities / General System Parameter Setup

General System Parameter Setup

Funds Settings Employee Settings Diaries / Text Fields Policy Interface Settings Globalization Settings

Department For Auto Population: B a

Use Single Sign On:
| Use Rule Engine: u |

[Fig. 2]

2. Mandatory requirement of a Database Server (either PostgreSQL or MongoDB)
for all APl based Import tools

A Database Server (either PostgreSQL or MongoDB) must be installed to act as a Staging area for all
Data Import Tools.

© 2024 DXC Technology Company. All rights reserved.
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DXC recommends the use of PostgreSQL as it is completely free to use

MongoDB (enterprise) may also be used, but it must be noted that it is a licensed
software for which additional costs will need to be paid

The PostgreSQL software may be downloaded on the Application Server itself or any
other server on the same network. However, it must be ensured that direct connectivity

to the Application Server is always maintained. A cloud-based service may also be used
for the same

e https://www.enterprisedb.com/downloads/postgres-postgresql-downloads
Customers hosted with DXC may please contact the Assure Claims Support Helpdesk to
get PostgreSQL installed
Any version of PostgreSQL (13.9 or higher) may be installed for your Operating System
Please keep the connection information handy before proceeding with the next steps

An example of a Staging Connectionstring

ID=<UserID>;Password=<password>;Server=localhost;Port=5432;Integrated
Security=true;Pooling=true;

Note

> Enter the ‘UserID’ and ‘password’ used during PostgreSQL setup

> If PostgreSQL is installed on the Application Server, then Server should be left as
“localhost”. Else, enter the server's name where PostgreSQL has been installed
The default PostgreSQL Port is 5432, however if a different port is used, please enter it
accordingly

3. Select the checkboxes - Use Import Tool and Use Extract Tool in the
Configuration Manager Zone

Navigate to the Import/Extract Tool subtab:

) . System Parameters Claims Module (tab)
Configuration

Manager (zone)

Setup > General ->Import/Extract
System Parameters Tool (subtab)

And select the checkboxes labeled Use Import Tool and Use Extract Tool. [Fig. 3]

© 2024 DXC Technology Company. All rights reserved.
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DXC Assure Claims (Configuration Manager) screen

——
>XC
TcumoLooy

Work in Progress

General System Parameters

Shared

SFTP

S3(AWS Storage)

£ RMIUT201_ACOFF_FRESH  [Z] DefaultView bi2141bi214 = ]
General System Parameters > c X
=] system £ Employee [=) Diaries / Text Fields £ Claims Module @ Third Party Module
Evaluation Mode Duration
T Aalylcs St Use Import Tool @ Use Extract Tool @
Import/Extract Tool
File Location @
¢ SFTP -

Server Userld Password Folder Location

Import Tool Database Type Import Tool Staging Database” Staging Connectionstring”

PaperVision Document -

Policy Interface

Rule Engine

[Fig. 3]

The File Location dropdown field has 3 options:

» Shared
> SFTP
» S3 (AWS Storage)
/

When the selected File Location is SFTP, then the following fields will be displayed:
» Server » Import Tool Database Type*
» UserID » Import Tool Staging Database*
» Password » Staging Connectionstring®
» Folder Location

When the selected File Location is S3(AWS Storage), then the following fields will be displayed:
» File Path* » S3 Region*
» S3 Bucket Name* » Import Tool Database Type*
» S3 Access Key » Import Tool Staging Database*
» S3 Secret Key » Staging Connectionstring*

When the selected File Location is Shared, then the following fields are displayed:
» Shared Location
» Import Tool Database Type*
» Import Tool Staging Database*
» Staging Connectionstring*

\-
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~

File Location

» This location will be used to place the Import Files as well as get the Extracts from DXC
Assure Claims

» A network shared path such a SFTP or S3 may be chosen by entering the necessary
details

Import Tool Database connection details

» Appropriate details for connecting to the Staging Database Server will need to be
entered

> If you are using PostgreSQL as staging database server, ensure that the database
which you entered in the field labeled “Import Tool Staging Database” [Fig.3] has
already been created on your PostgreSQL Database server before you import the
Import Tool package.

» Make sure that the Staging Connectionstring is accurate before proceeding to next
steps

- J

4. Select the checkbox labeled - API Flexible Searches, in the Security zone

For APl based Export Tool, navigate to the Security Management System screen and turn ON the
“API Flexible Searches” for the user who would schedule the Task Manager Jobs. [Fig. 4]

Security >
Security

API Flexible
Searches
(checkbox/node)

Module Access
Permissions >
RISKMASTER >

DataSources >
Module Security

M t
anagemen Groups > User

System

DXC Assure Claims screen
Security Management System

Security Management System

© 28 e EMBE3e O 0

Module Access Permissions

@ RISKMASTER SECURITY
© Users
© DataSources
© AC_Attach B 9 2

© AC221_BES_Maint

© AC222_ERON_MCOFF
© devops_221
© RM201_Automation
© RM20TNEW_BES
© RM212_AutoSmoke
@ RMIUT201_ACOFF_FRESH
© Permission To Login
@ Module Security Groups
©Q abc
© Aditi
© Administrator

© Module Access Permissions
@ [W[RISKMASTER

I © [m/API Flexible Searches

© W Claim
@ W Entity
© [ W|PAYMENT
W Appointments
© |m Catastrophe Maintenance

€ [mlrlzim Thnle
[Fig. 4]
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5. Download Microsoft OLE DB driver

To run the Import tool for MDB file to support modules such as MBR, Microsoft OLE DB Driver must
be installed in the Application Server.

Download the Microsoft OLE DB driver below:
DOWNLOAD MICROSOFT OLE
DB DRIVER

6. Download the ImportTool and ExtractTool PACKAGE Files and import them into
the DXC Assure Claims system

Note

» The package files for CHPs may be different from the GA release versions

IMPORTTOOL.PKG EXTRACTTOOL.PKG

Downloadable “PACKAGES"” were first introduced in release version 18.3. To know more about
PACKAGE download and their import into DXC Assure Claims (formerly RISKMASTER Accelerator/DXC
Insurance RISKMASTER™), please click on the adjoining Release Notes document and refer to pages
15 and 22 for details.

READ THE RELEASE NOTES FOR
VERSION 18.3

Important Note

> Please contact your DXC Assure Claims administrator to get the relevant package files

Introduction of an ability to create and run
Custom Import / Extract Jobs

© 2023 DXC Technology Company. All rights reserved.
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With the release of v. 23.1, DXC Assure Claims has made further progress towards the objective of delivering
APl based Extract and Import Tools by negating any dependencies on SAP interfaces.

To this end, the ability to create and run Custom Import/Extract jobs via the new API-based solution has
been introduced. The implementation caters to the Custom Data Exchange Requirements of both Import
and Extract jobs.

Note

> The existing/scheduled Import jobs in the Claim Scheduler module will stop working once the
client environment are upgraded/migrated to the latest version. DXC strongly recommends
rescheduling the existing Import jobs after migration/upgrade to 23.1.

Customers desirous of using the Custom Import/Extract jobs feature should reach out to their
Sales Contact/Project Manager or DXC Assure helpdesk. Our Implementation services team
would then analyze your business requirements and help you implement the same.

All the Custom Data Exchange jobs will now run directly from the Claim Scheduler without any
dependency on SAP. It even negates the need for server access (via Citrix or otherwise).

[E] PositivePay-OP-703-Import-PositivePay X

Completed With Error [PositivePay)

12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Parsing arguments.
12/20/2023 7:00:55 AM Hosting Environment is null
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Process started.
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Read Configuration.
12/20/2023 7:00:55 AM 2---12/20/2023 7:00:55 AM---Get Optionset.
12/20/2023 7:00555 AM 2---12/20/2023 71001585 AM——_httnas//d —olaime dwo_rmal com/el
12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.An error occured while fetching JWT.Authentication failed.
Please edit existing scheduled job once and try again.
> 12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.One or more errors occurred. (An error occured while
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.)
= 12/20/2023 70035 AN 1===12/20/2023 7:00:33 Al~==Job eascution luterrupted due LU eXivurs.0ie UL WULE SLEIULS UCCUried. (Al SLIVL UCCured wiile
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.)
> 12/20/2023 7:00:55 AM 1---12/20/2023 7:00:55 AM---Job execution interrupted due to errors.One or more errors occurred. (An error occured while
fetching JWT.Authentication failed. Please edit existing scheduled job once and try again.) System.Exception: An error occured while fetching
JWT.Authentication failed. Please edit existing scheduled job once and try again.
> at ImportTools.Helpers.JwtTokenAuth.GetRMAJWT(Globals Globals) in D:\ClaimsSchedulerAPI\data-exchange-
libs\Claims.ImportTool\Helpers\JwtTokenAuth.cs:line 62
> at ImportTools.Helpers.CommonService.GetAsync(String surl, Globals Globals) in D:\ClaimsSchedulerAPI\data-exchange-
libs\Claims.ImportTool\Helpers\Common.cs:line 394

> at ImportTools.Helpers.CommonService.CallAPI(String url, String methodtype, Object inputobject, Globals Globals) in D:\ClaimsSchedulerAPI\data-
exchange-1ibs\Claims.ImportTool\Helpers\Common.cs:line 368

© 2023 DXC Technology Company. All rights reserved.
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[E) PositivePay-OP-702-Export-PositivePay X

Completed With Error [PositivePay])

12/20/2023 6:42:52 AM "Process started."

> 12/20/2023 6:42:52 AM Hosting Environment is null
> 12/20/2023 6:4 "argument count is19"

> 12/20/2023 6:4 "user isviniteaml"

> 12/20/2023 6:4 "dsnRMIUT201_ACOFF_FRESH"

> 12/20/2023 6:4 "submoduleCoM"

> 12/20/2023 6:4 “Job Id is4218"

> 12/20/2023 6:4 "Optionset Id is702"

> 12/20/2023 6 “Getting Optionset"

> 12/20/2023 6 "Gettina JWT Token."

> 12/20/2023 6:42:52 "Error occurred in Class Name: Claims.ExtractTool.Services.JwtTokenAuth, Method Name: GetRMAJWT, Line Number: 69 Error message
is: An error occured while fetching JWT:

> Authentication failed. Please edit existing scheduled job once and try again.

.

> 12/20/2023 6:42:52 AM An error occured while fetching JWT:

> Authentication failed. Please edit existing scheduled job once and try again.

>

Procuring API based DE Tools

The procurement of API based DE Tools may involve additional cost/ consulting/ agreement/ licensing
considerations.

Please reach out to DXC Assure Claims Support or your DXC Assure Claims Sales Representative for more
information.

© 2023 DXC Technology Company. All rights reserved.
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MBR Import

To schedule an MBR Import job, go to Configuration Manager - Task Manager - Scheduler section - Job
Details > and schedule a Task by selecting MBR as Task Type and Import Tool as Sub Task Type. Enter
required data in the StartDate /End Date and Job Detail section.

DXC Assure Claims screen

Claim Scheduler > Cc X

2§ Dashboard El Jobs @ scheduler

(2)a)

° Job Detail @ OptionSet Parameters
© o Details
Task Type Task Name Sub Task Name Run Immediately
MBR ~ MBR Import >~ @
Email Notification
Diary Notification
[Fig. 5]
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Next, enter the frequency of job execution in Job Scheduler to get redirected to the OptionSet Parameters
tab. [Fig. 6]

DXC Assure Claims screen
Claim Scheduler >

2§ Dashboard El Jobs @ scheduler

()=

@ Job Detail e OptionSet Parameters

Option Set Information File Detail Option Entity Match Settings Payment Options Duplicate Criteria Options
Optionset Name” Bypass Script Editor Allow Creation of New Entities
O
Bypass Activity Logs 3 Import Type Mode Type
BOTH Validation a... -
%] FUNDS -
[Fig. 6]

The Optionset Parameters tab includes 4 sub-sections namely, OptionSet Information, File Detail Option,

Entity Match Settings, Payment Options, Duplicate Criteria Options. Enter relevant data in the respective
fields of each section.

DXC Assure Claims screen
Claim Scheduler >

2§ Dashboard El Jobs @ Scheduler

@ Job Detail e OptionSet Parameters

Option Set Information File Detail Option Entity Match Settings Payment Options Duplicate Criteria Options

File Format Read File from Configured Path

0O

Files to Import

EI o drep fles

[Fig. 7]
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The path for the Import File - Shared, SFTP or S3(AWS Storage, could be configured via the General System
Parameters screen in the Configuration Manager zone. Alternatively, the Import File can be directly
imported via the File Detail Option tab [Fig. 7] of the OptionSet Parameters section on the Claim Scheduler
screen.

Once all requisite information has been entered into the fields of all the accordions the Save button can be
selected to schedule the job.

For complete information on MBR Optionset Parameters, please
refer to the DA MBR Optionset User Guide document on the LOG INTO DXC CLAIMS

Claims Microsite > DXC Assure Claims Release Info 2> Data MICROSITE
Analytics > DE Modules Optionset User Guides > MBR

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Aborted

Filter by column name....
Completed 1 to 25 of 41 Page:10f2 > >l

Completed Wit...
Job Name Description Job state Start Date/Time End Date/Time Job Files

Running Completed
MBR-OP-139-Im DA_MBR 4 06/23/2022 12:44 PM 06/23/2022 12:44 PM n

Task List Completed
MBR-OP-91 DA_MBR ] 06/23/2022 12:42 PM 06/23/2022 12:43 PM n

Completed
EE B MBR-OP-91 DA_MBR n  06/23/2022 1241 PM 06/23/2022 12:41 PM [ ]

[Fig. 8]

To edit the scheduled job, select the clickable link to get redirected to the respective screen. To remove the
same, select the corresponding checkbox, followed by the Delete button from the top right corner.

Note

> With the new APl based MBR Import solution, the need to create a Reserve prior to

importing a payment has been resolved. You can now Import Payments without
Reserves as the system will automatically create the required Reserves in the
background

MBR Export

To extract for an MBR (Medical Bill Review), go to Configuration Manager - Task Manager - Scheduler
section > Job Details. Mentioned below are the various fields pertaining to it are mentioned below.

© 2023 DXC Technology Company. All rights reserved.
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Schedule a Task with the Task Type - MBR and Sub Task Name - Extract. Secondly, enter required data in
the StartDate /End Date and Job Scheduler section. Next, in the Medical Bill Review > Optionset
Parameters tab, enter a unique name for the Optionset and select Export Type. [Fig. 9]

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Job Detail 2 Start Date / End Date 3 Job Scheduler OptionSet Parameters

Medical Bill Review -> Optionset Parameters Medical Bill Review -> Entity Extract

Optionset Name Export Type

Op_Extract ENTITY Entity

PREVIOUS

[Fig. 9]

There are two types of Export Type namely, Entity and Claim. Depending upon the selection made in this
field, the Medical Bill Review - Entity Extract or Medical Bill Review - Claim Extract section will be
correspondingly displayed. Enter relevant data in the respective sections and select the Save button. The
created job will be displayed in the Task Manager - Jobs tab - Task List section. [Fig. 10]

DXC Assure Claims screen

Task Manager

Dashboard Scheduler

Aborted

Filter by column name....
Completed 1 to 25 of 41 Page:10of2 » >l

Completed Wit...

Job Name Job State Start Date/Time End Date/Time

Running Completed
MBR-OP-405-Ex... 06/23/2022 12:44 PM 06/23/2022 12:44 PM

Task List Completed
MBR-OP-403-Ex... 06/23/2022 12:42 PM 06/23/2022 12:43 PM

[
EE L MBR-OP-402-Ex... 06/23/2022 12:41 PM 06/23/2022 12:41 PM

[ ]
MBR-OP-399-Ex... 3/2022 12:36 PM 06/23/2022 12:36 PM

[Fig. 10]

To edit the scheduled task, select the clickable link to get redirected to the respective screen.

© 2023 DXC Technology Company. All rights reserved.
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While the Task Manager screen of the MBR Extract Tool has been completely redesigned
and given a modern look and feel, its functionality has not been altered.

The details of an existing MBR Extract job will be prefilled in the respective fields if the
same task is created again.
The data will be auto populated based on the selected Task Type and Sub Task Name.

PositivePay Import

Go to Configuration Manager > Task Manager > Scheduler section. This section features two tabs, namely,
Job Detail and OptionSet Parameters. In the Job Detail tab, schedule a Task with the newly added Task
Type - PositivePay and Sub Task Type - Import. Next, enter relevant data in the fields of the OptionSet
Parameters tab and select Save.

DXC Assure Claims screen
Claim Scheduler > c x

2§ Dashboard El Jobs @ scheduler

Q) DBk e OptionSet Parameters
Option Set Information File Detail Option
Optionset Name" 3 Import Type
v CLEARCHECK v
Mode Type”
BOTH Validation a... A
[Fig. 11]

It is important to note that earlier, the path for the Import File, whether Shared, SFTP, or S3(AWS Storage),
could only be configured via the General System Parameters screen in the Configuration Manager zone.

Thus, the extension of this additional option for Import File upload offers enhanced convenience by
contributing to a smoother PositivePay Import job workflows.

© 2023 DXC Technology Company. All rights reserved.
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DXC Assure Claims screen
Claim Scheduler > ca X

2§ Dashboard El Jobs @ scheduler

@ Job Detail e OptionSet Parameters

Option Set Information File Detail Option

File Pormat Read File from Configured Path

O

ACCOUNT_NUME... -

Files to Import

E orrep fles

[Fig. 12]

Based on the selections made on this screen, the task will be scheduled, and the PositivePay Import job
along with the job files will be displayed in the Jobs section of the Task Manager screen. [Fig. 13]

When the new onscreen file upload option is not used and instead the checkbox “Read File
From Configured Path” is selected, the “File Name” field will become editable

The file name format for API-based Import Tool jobs will be “filename.extension”, whilst earlier,
we were expecting file name without extension

A validation message will be displayed if the file extension isn't mentioned in the format
mentioned above

DXC Assure Claims screen

Task Manager > e X
2% Dashboard El Jobs @ scheduler
Aborted 0
Filter by column name.... )
Completed 296 1to 25 of 226 Page: 1 of 10 c @
Completed Wit... 209
D Job Name Description Job State Start Date/Time End Date/Time Job Files
Running Completed
O PositivePay-OP-... DA_PositivePay LN N 09/09/2022 7:50 AM 09/09/2022 7:52 AM ;]
Task List 0 . ) Completed
D PositivePay-OP-... DA_PositivePay — 09/09/2022 7:48 AM 09/09/2022 7:50 AM n
Completed
Total Jobs Exe... 435 (O PositivePay-OP-.. DA PositivePay ALY 09/08/2022 8:27 AM 09/08/2022 8:27 AM [ :]
[Fig. 13]
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PositivePay Extract

The Job for the PositivePay Extract tool can be scheduled and executed like any other job. For this, go to
Configuration Manager - Task Manager > Scheduler section. This section features four tabs, namely,

Start Date / End
Date

OptionSet

Job Detail
Parameter

Job Scheduler

In the Job Detail tab, schedule a Task with the newly added Task Type - PositivePay and Sub Task Type -
Extract. In the following tab, enter select the required Start Date and End Date. Next, enter the frequency of
job execution in Job Scheduler to get redirected to the OptionSet Parameters tab.

DXC Assure Claims screen
Claim Scheduler > c x

2§ Dashboard £l Jobs @ scheduler

()]

N £N = 4
Q/\ Job Detail ( 2/\ Start Date / End Date (3/ Job Scheduler o OptionSet Parameters

Option Set Information

Optionset Name” File Name™ Manually Change Date Range

O

Bank Account’

Bank Format’

[
Search ¥ |Search g

[Fig. 14]

This tab includes the following fields:

» Optionset Name Bank Format

>
» File Name » Bank Account
» Company Name/Title » Bank Account
» Manually Change Date Range » File Format
> Date From > Destination/Receiving Location
» DateTo
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Based on the selections made on this screen, the task will be scheduled, and the PositivePay will be
extracted. The created task will be displayed on the Jobs section of the Task Manager screen. [Fig. 15]

DXC Assure Claims screen

Claim Scheduler > c
2§ Dashboard El Jobs @ scheduler
Aborted 0
Filter Dy column name.
Completed
e I a2 11025 0f 320 D DPage:meD D c %
Completed With Error 61
Completed With Valida () JobName Description Job State Start Date/Time End Date/Time Job Files
Completed . . -
— () Financial History Proces...  Processes Financial History 2 06/13/2024 1:12 PM 06/13/2024 1:12 PM
Completed
MBR-OP-321-Export MBR 06/12/2024 4:59 PM 06/12/2024 5:00 PM
Task List 0 a o =2 /12/: /12/: [ 3]
[ Financial History Proces...  Processes Financial History M i 2 06/12/2024 3:04 PM 06/12/2024 3:04 PM
Total Jobs Executed 546
Ce leted
() Bes Scheduler Build BES groups N 2 06/12/2024 3:04 PM 06/12/2024 3:04 PM
Ce leted
itivePay-OP-319-Exp.. itivePay R 06/12/2024 1:30 PM 06/12/20241:30 PM
=

[Fig. 15]

To edit the scheduled task, select the clickable link to get redirected to the respective screen.

While the Task Manager screen of the PositivePay Extract Tool has been completely

redesigned and given a modern look and feel, its functionality has not been altered.

The details of an existing PositivePay Extract job will be prefilled in the respective fields if
the same task is created again.

The data will be auto populated based on the selected Task Type and Sub Task Name.

1099-MISC and NEC Extract

The 1099-MISC And NEC task type is now available on the Claim Scheduler screen of the Configuration
Manager zone.

With this integrated solution, the 1099 details can now be retrieved through an Extract tool without the
involvement of SAP configuration. The 1099 form is used to report non-employment income to the Internal
Revenue Service (IRS).

To extract the same, go to Configuration Manager > Task Manager > Scheduler section. In the Job Detail
section, schedule a Task with the newly added Task Type - 1099-MISC And NEC. Enter relevant data in the
fields of the Start Date/End Date and Job Scheduler tab.

Next, select necessary filter criterion in the Optionset Parameter section. [Fig. 16]
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Task Manager >

2§ Dashboard

EJ Jobs

DXC Assure Claims screen

@ scheduler

@ Job Detail

@ Start Date / End Date @ Job Scheduler

° OptionSet Parameters

Option Set Information

Settings Reserve/Transaction Settings Payee Settings

Optionset Name”

1099_Optionset

Specify Date Range Date From

MM/ddryyyy

Last Week Extract

O

Tax Year to Export

RollUp Payments on Export

O
[Fig. 16]

Date To
MM/ddryyyy D

Last Month Extract

O

Based on the selections made here, 1099 details will be extracted once the job is executed successfully. The
created task will be displayed on the Jobs section of the Task Manager screen. [Fig. 17]

Task Manager >

25 Dashboard

EJ Jobs

DXC Assure Claims screen

@ scheduler

Aborted 0
Completed 999+
Completed Wit... 999+
Running

Task List 0

Note

Filter by column name....

1 to 25 of 9968 Page: 1 of 399 c 0o
D Job Name Description Job State Start Date/Time End Date/Time Job Files
Completed
099-MISC And ... DA_1099-MISC And ... — 08/28/2022 5:49 PM 08/28/2022 5:49 PM n
Completed
D 1099-MISC And ... DA_1099-MISC And ... — 08/25/2022 6:39 AM 08/25/2022 6:39 AM n
[Fig. 17]

» The legacy DA 1099-MISC and NEC task is no longer available via the Utilities zone. This
task can only be accessed via the Configuration Manager zone.
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Addition of Entity Type filter options for Box 6

1099-MISC Reporting for Box 6 has been refined with the addition of new selection criteria - Entity
Category and Entity Type. With this enhancement, organizing and searching across 1099-MISC records
has been made easier as 1099 Reporting for Box 6 can be refined from a list of Reserve Types as well as
from a Subset of Entity Types.

Note

» For systems configured with the System Setting Entity Role marked as ON,
e The box listing the Entity Category will be displayed.

e The box listing the Entity Type and People Type will be disabled.

» For systems configured with the System Setting Entity Role marked as OFF,
e The box listing the Entity Type and People Type will be displayed.
e However, the box listing the Entity Category will be disabled.

After the settings are aligned in place, schedule a 1099-MISC and NEC job from the Task Manager screen.
For this, follow the path mentioned below:

Configuration Task Manager Seliesluler (50 Schedule 1099-

Manager (zone) (screen) MISC and NEC Task

Based on the System Setting, the Reserve/Transaction section will feature new fields, Box 6 Entity Category,
Box 6 People Type or Box 6 Entity Type field. Make necessary selections and execute the job. The data will
be extracted based on the filters applied on the Optionset as well as the Reserve/Transaction screen. [Fig.
18]
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DXC Assure Claims screen

€ RMIUT201_ACOFF_FRESH Defaultview
Claim Scheduler >

23 Dashboard E Jobs @ scheduler

e 11214 101214

@ Job Detail

° OptionSet Parameters

(2)(a]

Option Set Information Settings Reserve/Transaction Settings Payer Settings
Export All Payments for Tax Year Export Specific Transaction Types @ Export Specific Reserve Types @
Search - Search -
Box 6 Medical Reserve Type Box 6 Entity Category Box 6 People Type Box 6 Entity Type
Search A4 Search A4 Search - Search -
Box 10 Transaction Type Box 13 Transaction Type
Search - Search -

Note

» Moving forward, this feature will be available only in the new API based solution

(Configuration Manager zone). That is, DA 1099 Task will be removed from the legacy
Utility zone.

MMSEA Import and Extract

The ability to create and run MMSEA jobs via the new API-based solution is now available via the
Configuration Manager zone. The Scheduler screen now features a Optionset window for MMSEA Query

and Claim jobs.
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MMSEA Query/Claim Input via API-based Extract Tool

Navigate to the path mentioned below to avail the feature and schedule a MMSEA Claim Input job:

Configuration Manager - Claim Scheduler > Scheduler - Job Details - and schedule a Task by
selecting MMSEA as Task Type and Export as Sub Task Type. [Fig. 19]

DXC Assure Claims screen
Claim Scheduler > c X

%% Dashboard El Jobs @ scheduler

° Job Detail
© Job Details
Task Type Task Name Sub Task Name Run Immediately
MMSEA -  MMSEA Export ~ 0O
Email Notification
Diary Notification Send Notification Send Notification To
@ When Tasks are executed with... .,

[Fig. 19]

Next, enter the frequency of job execution in Job Scheduler to get redirected to the Option Set Information
tab.

In the Optionset Parameters tab, enter relevant data in the mandatory fields namely,

> Optionset Name: Enter a unique name for the Optionset.

» RRE ID: RRE ID can be defined from the Assure Claims fields. There are three fields, Client
Information, Department Level and the Policy Level.

» File Format: There are two formats available to choose from, wherein Claim (new added) exports
the Claimant & Claim details and Query exports the Claimant details only.

» Claim Type: Select the Claim Type from the dropdown list.

» Enable the Test Export checkbox.
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DXC Assure Claims screen

Claim Scheduler > c x

2§ Dashboard £l Jobs @ scheduler

@ Job Detail e OptionSet Parameters
Option Set Information Diary Settings
Optionset Name RRE Id” File Format~ Test Export
MMSEA-Optionsed 16 «  CLAIM Claim > 2
Export Only Primary Claimants Do not Include TPOCs Under Threshold Claim Typek
'd
D D |\ PREM Premises Liability )
T o
| LT Lost Time )
. /
Search hd
[Fig. 20]

Next, move to next newly added tab, Diary Settings. Select the checkbox labelled, Send Diary To Current
Adjuster, if needed.

Based on the selections made on this screen, the task will be scheduled, and the data will be extracted.

MMSEA Query/Claim Response job execution via API-based
Import Tool

Similarly, the MMSEA jobs can be scheduled for Imports as well. To schedule a MMSEA Import Type task, go
to Claim Scheduler - Scheduler > Job Details > and schedule a Task by selecting MMSEA as Task Type
and Import as Sub Task Type.

Fill relevant data in the Optionset Parameters tab:

» Optionset Name: Enter a unique name for the Optionset.
> Import Type: The field features two options:
e CLAIMANTMMSEA: CLAIMANTMMSEA can be used to import the Claimant & Claim details
via Claim file format and the Claimant details via the Query file format.
e TINMMSEA: This retrieves the RREID information by using this option.
> File Name: Enter the name of the file for which the import is being executed.
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> RRE ID: RRE ID can be defined from the Assure Claims fields. There are three fields, Client

Information, Department Level and the Policy Level.
» Mode Type: Select the option Both Validation and Data Import.

DXC Assure Claims screen

Claim Scheduler > e x
2§ Dashboard £l Jobs @ scheduler
VL} Job Detall ° OptionSet Parameters
Option Set Information File Detail Option Diary Settings

Optionset Name" Import Type RRE Id’

Optionset-import v TINMMSEA w 000056789 -
Mode Type”

BOTH Validation a... v
[Fig. 21]

It is important to note that earlier, the path for the Import File, whether Shared, SFTP, or S3(AWS Storage),
could only be configured via the General System Parameters screen in the Configuration Manager zone.

Thus, the File Detail Option tab of the window offers the extension of this additional option for Import File
upload offers enhanced convenience by contributing to a smoother MMSEA Import job workflows.

DXC Assure Claims screen

Claim Scheduler > c x
2§ Dashboard El Jobs @ scheduler
‘/"\) Job Detail ° OptionSet Parameters
Option Set Information File Detail Option Diary Settings
08 Format Read File from Configured Path
QUERY Query v
0  Fie Name |

Files to Import

E or drop files

[Fig. 22]
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Select the checkbox labelled, Send Diary To Current Adjuster, in the Diary Settings tab, if required.

The created task will be displayed on the Jobs section of the Claim Scheduler screen and the data will be
imported.

Improvements in APIl-based Import and
Extract Tool in the Claims Scheduler screen

The API-based Extract and Import Tools introduced in the previous releases have been further enhanced to
provide better usability in release version 23.4.

New Diary Sharing Option in MMSEA Import & Extract Tool

Earlier, the MMSEA Import & Extract jobs via the new APl-based solution allowed diaries to be shared
exclusively with the current adjuster. However, the latest release version of Assure Claims enables the
sharing of diaries with additional users as well. This enhancement has been achieved through a newly
introduced Send Diary to Additional Users option in the OptionSet Parameters section of the MMSEA
Import/Extract job screen. To access this capability, schedule a MMSEA task and in the Dairy Settings tab of
the OptionSet Parameter section, select the newly introduced checkbox, Send Diary to Additional Users.
[Fig. 23]

DXC Assure Claims Screen

Claim Scheduler > c X

2§ Dashboard £l Jobs @ scheduler

(2)(=)

PN
o /* Job Detail ° OptionSet Parameters

Option Set Information Diary Settings

Send Diary L Send Diary to Additional Users Select user
D @ | team1teami
Search -
|
[Fig. 23]
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PUS Import Tool

The primary objective of PUS Import tool is to update payment files received from third-party sources.
Consequently, the payment data is automatically populated into the Assure Claims system once the import
job is successfully executed.

However, this release version of Assure Claims introduces the APl-based PUS Import Tool feature as
part of Phase 1 implementation. This APIl-based solution will undergo further enhancements to

incorporate additional features in upcoming releases.

Scheduling a PUS Import job

To schedule a PUS Import job, go to Configuration Manager - Claim Scheduler - Scheduler section - Job
Details > and schedule a Task by selecting PUS as Task Type. Next, in the OptionSet Parameters tab, fill
in the following fields.

» OptionSet Name: Enter a unique name for the OptionSet.

» Import Task Type: Payment Update System will be displayed as a default option in this field.

» Import Type: There are two Import Types available, Payment and Payment Details. Choosing the
Payment option will result in an update to the Funds/Transaction screen, whereas selecting the
Payment Details option will update the Transaction Detail/Funds Split Detail screen.

» File Name: Enter the file name filename of the document that was previously uploaded based on
the Field Mapping Document in the location indicated on the General System Parameter screen.

» Mode Type: This field includes three options namely, Data Import, Validation & Validation and
Data Import. In case, Validation and Data Import or Validation option is selected, then, the File
Name field will become active. It will remain inactive if Data Import option is selected.

» Update Even if Blank or Zero: If this checkbox is selected, then, the job will be executed even if the
fields are blank.
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DXC Assure Claims Screen
Claim Scheduler > C X

25 Dashboard El Jobs @ scheduler

(o))

R
(1) Job Detail e OptionSet Parameters

Option Set Information

Optionset Name Import Task Type Import Type File Name”
o
Mode Type Update Even if Blank or Zero
BOTH Validation a... v D
[Fig. 24]

Enter relevant data in the fields and select Save to run the job. Based on the selection, the data will be auto
populated in the Funds/Transaction screen and Funds Split screen respectively.

Supplemental Field Mapping in PUS Import tool*

A new subtab labeled Supplemental Field Mapping is now available on the OptionSet tab to include
supplemental data mapping while scheduling a PUS job. It must be noted that the Supplemental tab on PUS
Optionset screen is visible only when Payment option is selected as the Import Type and Data Import is
selected in the field labeled, Mode Type.

Supplemental Field Mapping subtab screen components

The Supplemental Mappings grid available on this subtab consists of 46 Payment Supplemental rows
labeled FUNDS_SUPP_1... up till FUNDS_SUPP_46.

The grid consists of the following columns:

» Field Name » Supplemental Table
» Mapped » Supplemental Field
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DXC Assure Claims screen

Claim Scheduler >

| Zi Dashboard El Jobs @ scheduler

@ Job Detail

e OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals

Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 D
FUNDS_SUPP_2 @)
FUNDS_SUPP_3 0O

[Fig. 25]

The Mapped column consists of a checkbox, which if selected, will enable the dropdown fields in the

Supplemental Table and Supplemental Field columns. [Fig. 26]

DXC Assure Claims screen

Claim Scheduler >

| %3 Dashboard £l Jobs @ scheduler

@ Job Detail

Option Set Information Supplemental Field Mapping

° OptionSet Parameters

[2](a]

Supplemental Mappings

Payment Supplementals

Upon enabling a checkbox under the Mapped column, it will be possible to map the corresponding

Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 %] FUNDS_SUPP ']
LS5_INVOICE_ID
FUNDS_SUPP_2 D FUNDS_SUPP
FUNDS_SUPP_3 D
[Fig. 26]

Supplemental Table with a Supplemental Field so that this mapped data is imported, upon successful
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completion of the PUS Import job, and displayed in the Supplementals accordion of the Transaction screen.
[Fig. 27]

DXC Assure Claims screen
gy ®

+ B AR wE 0W>9 Q0 @F =@

Event (scf2023002823 * 15/11/2023) . General Claim (GCOONSWC

Transaction >
Transaction Detail ’
LSS Funds Info *
Supplementals -
Internal Claim Invoice 1:]
Q
Network Service Code Date Bill Received
[ ]
Date Bill Revd By Review Co Other Vendor Document Number
E
Bill Dacument Number Bill Review Company
Qg
LSS History Id LSS User id

Validation Messages

The validation message “The selected Payment Supplemental Field(s) FUNDS_SUPP_1 has not been mapped”
is displayed when attempt is made to save the Supplemental Field Mapping without selecting a
Supplemental Field. [Fig. 28]

DXC Assure Claims screen

Claim Scheduler > Cc X

0 The selected Payment Supplemental Field(s) FUNDS_SUPP_1 have not been mapped.
@ Job Detail e OptionSet Parameters

(2

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals v
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 @ FUNDS_SUPP v 4
FUNDS_SUPP_2 0 FUNDS_SUPP - -
[Fig. 28]
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The validation message “Selected supplemental column LSS_INVOICE_ID is mapped more than once with the
field(s) FUNDS_SUPP_1 and FUNDS_SUPP_2" when duplicate selections are made in the Supplemental Field
column. [Fig. 29]

DXC Assure Claims screen
Claim Scheduler > c X

o Selected supplemental column LSS_INVOICE_ID is mapped more than once with the field(s): FUNDS_SUPP_1,FUNDS_SUPP_2

@ Job Detail e OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals -
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 FUNDS_SUPP w | LSS_INVOICE_ID -
FUNDS_SUPP_2 FUNDS_SUPP w | LSS_INVOICE_ID - %
[Fig. 29]

The validation message “The Supplemental Field(s) LSS_INVOICE_ID is mapped multiple times with the
Field(s) : FUNDS_SUPP_1, FUNDS_SUPP_2" is displayed when the save button is clicked after making
duplicate Supplemental Field selections. [Fig. 30]

DXC Assure Claims screen
Claim Scheduler > c x

o The Supplemental Field(s) LSS_INVOICE_ID is mapped multiple times with the Field(s) : FUNDS_SUPP_1, FUNDS_SUPP_2.

@ Job Detail a OptionSet Parameters

Option Set Information Supplemental Field Mapping

Supplemental Mappings

Payment Supplementals v
Field Name Mapped Supplemental Table Supplemental Field
FUNDS_SUPP_1 FUNDS_SUPP w | LSS_INVOICE_ID -
FUNDS_SUPP_2 FUNDS_SUPP w | LSS_INVOICE_ID -
[Fig. 30]
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HR Interface Import Tool

Assure Claims v.24.3 introduces the new API-based HR Interface Import tool thus rendering the DA-based
HR Interface Import tool obsolete.

The HR Interface Import tool for Employees offers an option to effortlessly import or validate Employee
data. This module simplifies the task of maintaining data integrity, enhances productivity, and provides a
seamless method to expedite day-to-day operations and performances.

In simpler terms, the HR Import tool serves as a unidirectional means to bring in employees’ demographic
information from any external system into the Assure Claims application. Keeping the application in sync
with the HR system ensures that employee data remains current when linked to Events or Claims.

The tool initially searches for a matching employee in the Assure Claims database, based on specified
settings. If a match is identified, it proceeds to update the existing employee record. In the absence of a
match, the tool treats the employee as new and inserts their information into the Assure Claims application.

Scheduling an HR Interface Import Job

To schedule an HR Interface Import job, select the HR_Interface option for the Task Type field followed by
the Import option for the Sub Task Name field, then select the Run Immediately checkbox before clicking
on the Next button.

DXC Assure Claims screen

Claim Scheduler > a X

%% Dashboard £l Jobs @ scheduler

()]

o Job Detail @ OptionSet Parameters
° Job Details
Task Type Task Name Sub Task Name Run Immediately
HR_Interface w  HR.nterface Import >y 9
Email Notification
Diary Notification
[Fig. 31]

Upon selecting the Next button, the OptionSet Parameters section opens.
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The various components of the OptionSet Parameters section are described below:

DXC Assure Claims screen
Claim Scheduler >

C X
23 Dashboard E] Jobs @ scheduler
@ Job Detail Q OptionSet Parameters.
Option Set Information Match Criteria Limit Actions sSupplemental Field Mapping Import File Length
Optionset Name™ File Name™ @ Import Type” Mode Type®
TC3txt mewee .’ BoTH on a... v
File Format’
Employee
CHARACTERS_Fl... -
Payment
[Fig. 32]

Optionset Information tab

The Optionset Information tab consists of the following fields:

» Optionset Name - enter an apt name in this mandatory field
» File Name - enter a file name with file extension for the file that will be uploaded at the shared
location, SFTP or AWS. This field will be prepopulated if file has already been uploaded
» Import Type - there are 2 options available, namely
e Employee
e Payment

When Employee is selected as the Import Type option, then the following tabs become
available on the OptionSet Parameters screen
e Match Criteria
Limit Actions

Supplemental Field Mapping
Import File Length
When Payment is selected as the Import Type options, then the following tab becomes
available on the OptionSet Parameters screen
e Supplemental Field Mapping
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» Mode Type - This field includes three options namely,
e Data Import
e Validation
e Validation and Data Import (recommended)

Note

> In case the Validation and Data Import or the Validation option is selected, then, the

File Name field will become editable. It will remain inactive if Data Import option is
selected.

Mode Type X

Filter by column name..

frosors D Dpage:10f1D D = *
Short Code Description Parent Code
BOTH Validation and Data Import (R ded) -
DATAIMPORT Data Import I
‘VALIDATION Validation . e

» Import Task Type - is a prepopulated uneditable field

» File Format - has 3 options to choose from, namely
e 79-Characters File Format (used when Import Type is Payment)
e 88-Characters File Format (used when Import Type is Payment)
e Text (used when Import Type is Employee)

File Format X

1to3of 3 DDPage:1of1DD c 0

Short Code Description Parent Code

Filter by column name...

CHARACTERS_FILE_F... 79-CHARACTERS FILE FORMAT

CHARACTERS_FILE F... 88-CHARACTERS FILE FORMAT I

TEXT Text
4
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When “Employee” is selected as the Import Type

As mentioned above, when the Employee option is selected in the Import Type field, then the following tabs
become available:

» Match Criteria » Supplemental Field Mapping
» Limit Actions » Import File Length

Match Criteria tab

The Match Criteria tab includes the following two matching criteria -

» Employee Match Criteria
e Employee Number
Employee Number and Last Name
Employee Number if not match then SSN
Employee SSN
» Supervisor Match Criteria
e First Name and Last Name
e First Name, Last Name and Employee Number
e First Name, Last Name and Tax ID
e First Name, Last Name and Employee Number/Tax ID

The new employee data in the import file that aligns with the selected criteria in this tab will be imported,
resulting in the update of existing Employee and Entity records. [Fig. 33]

DXC Assure Claims screen

Claim Scheduler > c X

25 Dashboard El Jobs @ scheduler

@ Job Detail ° OptionSet Parameters
Option Set Information Match Criteria Limit Actions Supplemental Field Mapping Import File Length
Employee Match Criteria” Supervisor Match Criteria”
Employee Number W First Name and Last Name v
Employee Number First Name and Last Name
Employee Number and Last Name First Name, Last Name and Employee Number m
Employee Number If Not Match Then SSN First Name, Last Name and Tax ID
Employee SSN First Name, Last Name and Employee Number/Tax ID [Flg, 33]
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Limit Actions tab

Next, the Limit Actions tab [Fig. 31] presents several checkbox options to choose from. These are:

» Do not update Email field (only insert new)

Do not update Hourly Rate if new value is zero

Do not update Weekly Rate if new value is zero

Do not import if Department is missing or does not exist
Default workdays per week

Ignore Duplicate SSN

YV V V V V

Choose the relevant ones to apply limits to the import criterion.

DXC Assure Claims screen

Claim Scheduler > Cc X

2§ Dashboard El Jobs @ scheduler

(2)(=)

@ Job Detail o OptionSet Parameters
Option Set Information Match Criteria Limit Actions Supplemental Field Mapping Import File Length
Do not import if Department is missing or does not

Do not update Email field (only insert new) Do not update Hourly Rate if new value is zero Do not update Weekly Rate if new value is zero exist

%] %]

Default work days per week Ignore Duplicate SSN

7 A4

S

: =

7

[Fig. 34]

Note

> If the checkbox “Ignore Duplicate SSN” is not selected, then Import Errors may be

logged due to the presence of duplicate SSN(s) in the Import File
» As aresult, entry for the new employee will not be created in the database

Supplemental Field Mapping tab

Next in the OptionSet Parameters section if the Supplemental Field Mapping tab [Fig. 32] which is used to
include employee supplemental data mapping while scheduling a HR Import job.
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The Employee Supplemental mappings grid consists of the following columns:

>

>
>
>

Field Name
Mapped (checkbox)
Supplemental Table
Supplemental Field

Along with these, the Employee Supplemental mappings grid consists of 12 rows labeled TextSuppaA till

TextSuppK and the last row labeled DateSuppL.

Claim Scheduler >

2% Dashboard

El Jobs

DXC Assure Claims screen

@ scheduler

O

Job Detail

Option Set Information

Match Criteria Limit Actions

e OptionSet Parameters

Supplemental Field Mapping

Import File Length

Supplemental Mappings

Employee Supplementals

Field Name

Mapped

Supplemental Table

Supplemental Field

TextSuppA

Q

EMP_SUPP

TextSuppB

NUMBER_NUM

TextSuppC

TextSuppD

TextSuppE

TextSuppF

TextSuppG

TextSuppH

TextSuppl

TextSuppJ

TextSuppK

DateSupplL

0|00 0|0|O0|O0|O0|O0|O O
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Upon enabling a checkbox under the Mapped column, it will be possible to map the corresponding
Supplemental Table with a Supplemental Field so that this mapped data is imported, upon successful
completion of the HR Interface Import job.

Import File Length tab

Lastly, the Import File Length tab displays a set of 49 fields, providing an option to update the import file
length. In case, certain fields are not being imported, they can be left at their default value, which is zero.

Claim Scheduler >

%5 Dashboard

El Jobs

DXC Assure Claims screen

@ scheduler

@ Job Detail

Option Set Information

Match Criteria

Limit Actions

e OptionSet Parameters

Supplemental Field Mapping

Import File Length

Cost Center Code SSN Filler Size Hire Date Birth Date
1 9 o] 0 0
Sex MaritalStatus Home Phone Address Address 2 City
0 0 0 o] 0 0
State Zip Code NCCI Class Code Department Abbreviation County Country
0 0 0 6 0 0
Work Phone (Office) Fax Number Termination Date Pay Type Code Active Flag Full Time Flag
0 0 0 o] 0 0
Exempt Flag Employee Number Position Code Email Address First Name Middle Name
0 0 0 0 0 0
Last Name Also Known As Hourly Rate Weekly Rate Supervisor First Name Supervisor Last Name
3 0 0 o] 0 0
Job Class Driver License number Supervisor Employee Number Supervisor Tax ID Text Supp A Text Supp B
0 0 7 o 6 8
Text Supp C Text Supp D Text Supp E Text Supp F Text Supp G Text Supp H
0 0 0 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L

0

0

0

0

[Fig. 36]
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Note

> The sequence of these 51 fields must not be altered for successful records import
» The system will display a position length error in case this sequence is disrupted

Once all requisite information is filled and the HR Interface Import task is executed successfully, the
relevant employee data will be imported and filled in the respective fields of the Employee and Entity
Maintenance screens of the Maintenance zone. In the Employee screen, the imported data will be
populated in the Employee, Employment Info and Employee Info accordions, respectively.

When “Payment” is selected as the Import Type

On the Option Set Information tab, when Payment is selected as the Import Type, then only the
Supplemental Field Mapping tab becomes available on the on the OptionSet Parameters section. [Fig. 37]

DXC Assure Claims screen
Claim Scheduler > a X

| 2§ Dashboard E] Jobs @ Scheduler

(2)(&)

@ Job Detail e OptionSet Parameters
Option Set Information Supplemental Field Mapping
Optionset Name™ File Name™ @ Import Type” Mode Type
HRIntimp TC3.txt Payment - BOTH Validation a... -
File Format’
CHARACTERS_FI... w
[Fig. 37]

Move to the Supplemental Field Mapping tab after making all requisite selections on the Option Set
Information tab. [Fig. 38]
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Supplemental Field Mapping tab

The Supplemental Field Mapping tab consists of a grid with the following columns, checkbox, and rows:

» Field Name (column) » Supplemental Field (column)
» Mapped (checkbox) > Vendor ID (row)
» Supplemental Table (column)

DXC Assure Claims screen

Claim Scheduler > e X

%3 Dashboard El Jobs @ scheduler

@ Job Detail e OptionSet Parameters
Option Set Information Supplemental Field Mapping
Supplemental Mappings
Entity Supplementals hd
Field Name Mapped Supplemental Table Supplemental Field
Vender ID ENTITY_SUPP ~ e

INDEX_BUREAU_NUMB

[Fig. 39]

Upon enabling a checkbox under the Mapped column, it will be possible to map the corresponding
Supplemental Table with a Supplemental Field so that this mapped Payment data is imported, upon
successful completion of the HR Interface Import job.

Validation Messages

The following are the validation messages that you can come across while scheduling an HR Interface
Import job.
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DXC Assure Claims screen

Claim Scheduler > e x

0 Please provide File Name.

&y

@ Job Detail ° OptionSet Parameters

Option Set Information Supplemental Field Mapping
Optionset Name™ File Name” Import Type” Made Type
bnbb " BOTH Validation a... -
Employee
File Format™
Payment
CHARACTERS_FI... -
[Fig. 40]

DXC Assure Claims screen

Claim Scheduler >

Q File Formal needs lo be selected as 'T9-CHARACTERS FILE FORMAT' or '88-CHARACTERS FILE FORMAT with impert type ‘Payment’.

@ Job Detail ° OptionSet Parameters

Option Set Information Supplemental Field Mapping
Optionset Name' File Name” Import Type” ade Type
bvbnbn TC4.txt Payment B0TH Validion a... v
File Format™
- . TEXTTem o -
[Fig. 41]
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DXC Assure Claims screen

Claim Scheduler >

o File Format needs to be selected as '79-CHARACTERS FILE FORMAT' or "88-CHARACTERS FILE FORMAT" with import type 'Payment'.

@ Job Detail ° OptionSet Parameters

Option Set Information Supplemental Field Mapping
File Name " Import Type” Mode Type’
TCA.txt payment BOTH Validation a... -
File Format’

HR Interface v TEXT Rt o v
[Fig. 42]
DXC Assure Claims screen
Claim Scheduler > c x

o Flle Formal needs 1o be selected as TEXT with import tlype "Empiloyee’.

@ Job Detail ° OptionSet Parameters

Option Set Information Match Criteria Limit Actions Supplemental Field Mapping Import File Length
File Name~ Import Type Mode Type’
TCA.txt Employee BOTH Validation a... -
File Format’
S Aadaion _ CHARACTERS FILE F... o -

[Fig. 43]
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DXC Assure Claims screen
Claim Scheduler > (e}

0 MaritalStatus length must be in between 0 and 25

Q Sex length must be in between 0 and 25

' 0 Birth Date length must be in between 0 and 8
0 Hire Date length must be in between 0 and &
0 Filler Size length must be in between 0 and 50
9 SSN length must be in between 0 and 20

0 Cost Center Code length must be in between 0 and 25

Sex MaritalStatus Home Phone Address Address 2 city

0 o 0 5 3 [

State Zip Code NCCI Class Code Department Abbreviation County Country

2 5 4 6 3 3
[Fig. 44]

DXC Assure Claims screen
Claim Scheduler > c

e

0 Supervisor Tax ID length mus! be in between 0 and 20

0 Supervisor Employee Number length must be in between 0 and 20

€) Driver License number length must be in between 0 and 20

€ Job Ciass length must be in between 0 and 25

0 0 o 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L
0 0 0 0
——
[Fig. 45]
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DXC Assure Claims screen

Claim Scheduler

€) vate Supp L lengin must be in between 0 and 8
e Text Supp K length must be in between 0 and 255

( 0 Text Supp J length must be in between 0 and 255
0 Text Supp | length must be in between 0 and 255
0 Text Supp H length must be in between 0 and 255

0 Text Supp G length must be in between 0 and 255

0 Text Supp F length must be in between 0 and 255

Job Class Driver License number Number Supervisor Tax ID Text Supp A Text Supp B

0 0 0 0 0 0
Text Supp C Text Supp D Text Supp E Text Supp F Text Supp G Text Supp H
0 0 0 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L
0 0 0 q
[Fig. 46]

DXC Assure Claims screen

Claim Scheduler

0 Last Name length must be in between 0 and 255

° Middie Name length must be in between 0 and 255

Job Class Driver License number Number Supervisor Tax ID Text Supp A Text Supp B

1 7 4 4 0 0
Text Supp C Text Supp D Text Supp E Text Supp F Text Supp G Text Supp H
0 0 0 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L
0 0 0 0
[Fig. 47]
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Claim Scheduler >

DXC Assure Claims screen

‘ 0 First Name length must be in between 0 and 255

€) Emaiaduress lengin must be in between 0.ana 100
( 0 Position Code length must be in between 0 and 25

0 Employee Number length must be in between 0 and 20

0 Exempt Flag length must be in between 0 and 1

Cc X

3 5 4 4 4 4
Supervisor Employee
Job Class Driver License number Number Supervisor Tax ID Text Supp A Text Supp B
1 7 4 4 0 0
Text Supp C Text Supp D Text Supp E Text Supp F Text Supp G Text Supp H
0 0 0 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L
0 0 0 0
[Fig. 48]

Claim Scheduler >

Q Active Flag length must be in between 0 and 1

DXC Assure Claims screen

c X

9 Pay Type Code length must be in between 0 and 25

( 9 Termination Date length must be in between 0 and 8

Q Fax Number length must be in between 0 and 30

0 Work Phone (Office) length must be in between 0 and 30

1 4 3 15 3 L
Last Name Also Known As Hourly Rate Weekly Rate Supervisor First Name Supervisor Last Name
3 S5 4 4 4 4

Supervisor Employee
Job Class Driver License number Number Supervisor Tax ID Text Supp A Text Supp B
1 T 4 4 0 0
Text Supp C Text Supp D Text Supp E Text Supp F Text Supp G Text Supp H
0 0 0 0 0 0
Text Supp | Text Supp J Text Supp K Date Supp L
0 0 0 0

[Fig. 49]
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DXC Assure Claims screen
Claim Scheduler > e X

€) country length must be in between 0 and 25

0 County length must be in between 0 and 50

{ Q Department Abbreviation length must be in between 0 and 25
0 NCCI Class Code length must be in between 0 and 25
o Zip Code length must be in between 0 and 10

0 State length must be in between 0 and 5

Q City length must be in between 0 and 50

0 Address 2 length must be in between 0 and 100

0 Address length must be in between 0 and 100

Work Phone (Office) Fax Number Termination Date Pay Type Code Active Flag Full Time Flag

9 T 8 1 1 1

Exempt Flag Employ P Code Email Address First Name Middle Name

1 7 3 15 3 1 -
[Fig. 50]

DXC Assure Claims screen

Claim Scheduler > e X

o Please select File Format.

@ Job Detail o OptionSet Parameters

Option Set Information Match Criteria Limit Actions Supplemental Field Mapping Import File Length
File Name Import Type” Mode Type
TCAtxt Employee BOTH Validation a... =
File Format’
HR Interface ~ Search -
[Fig. 511
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HR Interface Export Tool

The API-based HR Interface Export Tool is now available on the Claim Scheduler screen of the
Configuration Manager zone. This HR Interface enables the effortless export of Payee data associated with
Payments made within the Assure Claims system.

To schedule an HR Interface Export job, navigate the following path and schedule a HR Interface Export

Task:

Configuration Manager - Claim Scheduler - Scheduler (tab) > Job Details (section) > schedule a Task by

selecting HR_Interface as Task Type with Sub Task Name as Export.

DXC Assure Claims screen

X TecHNOLOGY =

Defaultiew

-

Po

Work in Progress Claim Scheduler > c x
Claim Sehecuier I 25 Dashboard El Jobs @ scheduler
~ N
° Job Detail (2 ) start Date ! End Date (3 ) Job Scheduler
° Job Details

Task Type Task Name Sub Task Name Run Immediately

HR_Interface w  HR_Interface Export - D

Email Notification

Diary Notification

[Fig. 52]

The Scheduler screen for HR Interface Export consists of three sections - Job Detail, Start Date/End Date
and Job Scheduler.

The Job Detail section consists of the following dropdown fields and checkboxes:

»

>
>
>

Y

Task Type (select the HR Interface option from the dropdown)
Task Name (field auto populates when Task Type is selected)
Sub Task Name (select Export from the dropdown)

Email Notification (select this checkbox to set up task completion/failure notifications via email to
designated recipients)
Diary Notification (select this checkbox to set up task completion/failure notifications as Diaries to

designated users)
Run Immediately (selecting this checkbox runs the HR Interface task immediately)

e Selecting this checkbox removes the Start Date/End Date and Job Scheduler sections
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Selecting the Run Immediately checkbox followed by the Next button opens the Optionset Parameters
section. [Fig. 53]

DXC Assure Claims screen

Wi ProarEss Claim Scheduler > e x
Ciaim Scheduler 2% Dashboard &l Jobs @ scheduler
": ) Job Detail ( 2 ) start Date / End Date .j ) Job Scheduler 0 OptionSet Parameters .
Option Set Information Suppl tal Field Mapping

Optionset Name Export Type Test Export

HR_Interface-OP Payment ro

Payee
!

Vendor Id Validation m

[Fig. 53]

The Optionset Parameters section for a HR Interface Export Task consists of the following:

» Optionset Name (mandatory field)

» Test Export: Typically, when an extract job is executed, the same data cannot be extracted again. By
selecting this checkbox, the extraction of a test export file is enabled. This allows verification before
extracting the final export file.

» Export Type (dropdown)

e Payment
e Payee
e Vendor ID Validation

Of the three Export Types, Payment and Vendor ID Validation extracts have associated Supplemental Field
Mappings. These mappings enable the extraction of supplemental information against Payment or Vendor
ID Validation.

To extract specific supplemental information for a particular Optionset, select the desired option from the
Supplemental Mappings dropdown list. The respective Field Names will be displayed. Next, activate the
checkboxes next to each field and map its Supplemental Table to the corresponding Supplemental Field.
[Fig. 54]

The Payment Optionset comprises four Supplemental Mapping options, each of which includes the
following corresponding supplemental fields:

» Payment Supplementals
e Payment Terms
e RU # (mandatory field)
e Special Handling
e Separate Checks
e Account # (mandatory field)
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» Employee Supplementals

e Employee Vendor ID

» Entity Supplementals
e Entity Vendor ID
» Physician Supplementals
e Physician Vendor

ID

Select the Vendor ID Validation Optionset to verify whether the Payee Entity has a valid vendor ID or not. In
this context, the Payee Entity is referred to as the vendor. The supplemental mapping options along with
their respective supplemental fields for Vendor ID Validation are listed below:

» Employee Supplementals
e Employee Vendor ID

» Entity Supplementals
e Entity Vendor ID
» Physician Supplementals

e Physician Vendor ID

Workin Progress Claim Scheduler >

Claim Scheduler 2§ Dashboard £l Jobs

DXC Assure Claims screen

@ scheduler

Payment Supplementals
Employee Supplementals
Entity Supplementals

Physician Supplementals

N
1\:; Job Detail

Option Set Information

=N
) Start Date / End Date

Field

7N
(3 ) Job scheduter

\

° OptionSet Parameters

Supplemental Mappings

Payment Supplementals

Mapped

Supplemental Table

Supplemental Field

Payment Terms

RU #

Special Handling

(@]

Separate Chacks

(@]

Account #

O

A HR Interface Export Task can be scheduled by entering an appropriate Optionset Name followed by
selecting the desired Export Type. Finally, selecting the Save button runs the task immediately.

The scheduled HR Interface Export Task for the selected Export Type can be seen in the Task List node of

the Jobs tab on the Claim Scheduler screen. [Fig. 56]
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DXC Assure Claims screen

X tecHNOLOGY = (E) DefaultView

Work in Progress Claim Scheduler >

Do
il
[ad]

Ciaim Scheguier 25 Dashboard £l Jobs @ scheduler

Aborted 0
Complated 254
Completed With Error 179 Filter by column name
Running
Task List 0

[ Action Task Name
Total Jobs Executed —

o#

Next Run Date/Time

02/23/2024 6:03 AM

[Fig. 57]

1to1of1 DDPagezchDD c o

At 0603 AM, on day 23 of the month, only in February. anly in 2024

When the Task has run successfully, it can be viewed in the Completed node of Jobs tab. [Fig. 58]

DXC Assure Claims screen

SXC 1ecHNoOLOGY (5] Defaultview

Woerk in Progress Claim Scheduler >

Claim Scheduler 2§ Dashboard L Jobs

@ scheduler

-]

De

Aborted 0

Filter by column name.

Completed 265

Gompleted With Error 179
Running
Task List 0

Total Jobs Executed

(D HR_Interface-OP-408-E...

Description
HR_Interface

HR_Interface

Job State

Completed

Completed

[Fig. 58]

102507255 I:] I:]Page:mfn I:] D c o

Start Date/Time End Date/Time Job Files
02/23/2024 6:03 AM 02/23/2024 6:04 AM [ ;] =
02/22/2024 2:59 PM 02/22/2024 2:59 PM [ :] I

[E] R Interface-0-209-Export-HR_Interface
Completed [WR_Interface]

55 AM “Process started.”
“argusent count 1s19"
“user isvkumar?™
“dsnRMIUT201_ACOFF_FRESH™
“submodulePAYEE ™

“Jeb Id is737%
“optionset Id is489”

2/23/2024 &
2/23/2024 ®:
2/23/2024 &
2/23/2024 6:03:
2/23/2024 6:03:
2/23/2024 6:03

> 2/23/2024 6:03:
2/23/2024 6:03: “Getting Optionset™

“Getting INT Token."

“Getting Optionset from database."

2/23/2024 6

2/23/2024

2/23/2024 6:03:57

2/23/2024 6:03:57

2/23/2024 6:03:57

2/23/2024 6:03:57

2/23/2024 6:04:02

2/23/2024 6:83: “Extract Service Started.”
2/23/2024 6:9:

> 2/23/2024 6:03:5
2/23/2024 &:
2/23/2024 &:
2/23/2024 6:93:

> 2/23/2024 6:04:02

“Preparing Search Request.”
--"Sending Extr

“https://dev-
--"Extract Respo

“Uploading ile to SFTP."

EEEEEEEEERERERERGE:

dxc-racl.con/clainsapl /entity™

“File Uploaded to /client-store/PS/PAYEE_EXport_20248223068355. txt™

The HR Interface Payee
Export Task log can be
viewed by clicking on the
icon in the Job State
column.

A new “Job State” for correct job status
reporting of Import/Export Jobs
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A new Job State - “Completed With Validation Errors” is now available on the Jobs tab of the Claim
Scheduler screen in the Configuration Manager zone.

Until the previous release, Import/Export jobs with validation errors generated during execution were
also labeled as Completed under the Job State column giving a false impression of their successful
execution. Now, when Import/Export jobs are flagged as “Completed With Validation Errors” it

provides users with an opportunity to fix/resolve their underlying issues.

Thus, the introduction of this new Job State “Completed with Validation Errors” ensures that correct job
statuses are reported for each executed Import or Export job.

DXC Assure Claims screen

Claim Scheduler > CcC X

%5 Dashboard El Jobs @ scheduler

Aborted 0
Filter by column name..

Compialed 5 1t0250f 25 D D Page:10f 1 D D c @

Completed With Error 24

I
I

Completed With Va... [J Job Name Description Job State Start Date/Time End Date/Time Job Files
() MBR-OP-39-Import MBR Sompistoch R Valiation E"‘"s. 04/25/2024 6:25 AM 04/25/2024 6:27 AM [ 3]
-0P-99-Impo : :
Running
Completed With Validation Errors
S [0 MmBeR-0P-98-Export MER 04/24/2024 12:44 PM 04/24/2024 12:44 PM [ :]
ask Lis 0 -
Completed With Validation Errors
[ rus-op-a4 PUS 04/23/2024 1132 AM 04/23/2024 11:33 AM [ :]
Total Jobs Executed 929 -
[Fig. 59]
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Issue: The Import/Export Job fails when the Admin’s password is changed.

Fix: When the login password for an admin user is updated after scheduling API-based Import/Export job(s)
(MBR, PPY, MMSEA, 1099 and PUS) then it is recommended that the job(s) be edited and rescheduled to
avoid encountering credentials authentication failure messages in the job console logs.

Issue: The console log displays a network error message when a job runs continuously for 10 min or
more.

Fix:  Navigate to the appsettings.json file of Claim Scheduler and Claims APl and search for the key
“HttpClientTimeOut" and change its value from default to 30 or 45 or 60 as needed.

Issue: The Export Job log displays an SSL connection error.
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Fix:

E PositivePay-0P-133-Export-PositivePay
Completed With Error [PositivePay)

57372024 9:04:35 M "Process started.”
$/3/2024 9:04:35 M\ Targusent count 1s519°
S$/3/2024 9:04:35 AN “user isjlebn”
S/73/2024 9:04:35 AN “dsnlMICH-Production™
$/3/2024 9:04:35 AN " submodul eBNYCOMP™
S/3/2024 9:04:35 AN "Job 1d is19221"
$/3/2024 9:04:35 MM "Optionset Id is133"
$/3/2024 9:04:35 AN “Getting Optionset™
S/3/2024 9:04:35 AN "Getting INT Token."
$/3/2024 9:04:36 AN “Getting Optionset from database.”
$/3/2024 9:04:36 AN "One or more errors occurred. (The SSL comnection could not be established, see inner

exception. )Clales . ExtractTool .Services AssureClalimsService CallAssureClalimsAPT 129
> 5/3/2024 9:04:36 AN One or more errors occurred. (The SSL comnection could not be established, see inner exception.)

Check the values for the following 2 keys in the Claims API AppSetting.json:
"ResourceAPIBaseUrl": "http://localhost/claimsapi/”,

"SettingsAPIBaseUrl": "http://localhost/claimsapi/”,

Ensure that the following keys should have the same value as that for the above keys:
"RiskmasterAPI": "http://localhost/riskmasterapi/",
"SearchAPI": "http://localhost/claimsapi/",

"DataAnalyticsAPI": "http://localhost/claimsapi/”,

Check the values for the following 3 keys in the Claim Scheduler AppSetting.json
"SearchAPI": "http://localhost/claimsapi",
"RiskmasterAPI": "http://localhost/RiskmasterAPI",

"ImportToolAPI": "http://localhost/claimsapi",
The following keys should have the same value as that for the above keys:
"DataAnalyticsAPI"; "http://localhost/claimsapi”,

"AssureClaimsFileUploadAPI": "http://localhost/claimsapi”,

If the issue persists, please contact the DXC Assure Claims Support Helpdesk for assistance.
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Issue: Validation Errors are displayed for Import File name format.
Fix: With the release of DXC Assure Claims v.24.2 onwards, file name format for API-based Import Tool jobs will
be “filename.extension”, whilst earlier, we were expecting file name without extension.

This change will have no impact on the prescheduled jobs, but all new jobs will require the full file name to
be provided while scheduling the Import Tool jobs.

A help icon on the file name control is also added on the job screen to avoid any confusion.

Claim Scheduler >

Cc X
i Dashboard El Jobs @ scheduler
@ Job Detail ° OptionSet Parameters
Option Set Information File Detail Option Entity Match Settings Payment Options Duplicate Criteria Options Fee Payments

" - 3 Please enter full file name
File Format Read File from Configured Path File Name % (filename extension).

MDB format For Corvel(Without Line ltems) A

Files to Import

l:l orerop fles
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